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Prestigio Visconte 1450W
User’s Manual

Notice

The company reserves the right to revise this publication or to change its contents without notice. Infor-mation
contained herein is for reference only and does not constitute a commitment on the part of the man-ufacturer or any
subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this
publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this
publication. This publication and any accompanying software may not, in whole or in part, be reproduced, translated,
transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes. Brand and product names mentioned in this
publication may or may not be copyrights and/or registered trademarks of their respective companies. They are men-
tioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.

©January 2006

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents
and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright
protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited
viewing uses only unless otherwise authorized by Macrovision Cor-poration. Reverse engineering or disassembly is
prohibited. Intel®, Pentium® and Celeron® are US registered trademarks of Intel Corporation.
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FCC Statement
(Federal Communications Commission)

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference
to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to
persons when using any electrical equipment:
1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may
be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode.
Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (DC Output 20V, 3.25A (65W) minimum AC/DC Adapter,
OR by a DC Output 20V, 4.5A (90W) minimum AC/DC Adapter if you are using the optional port replicator- see pages 7
- 12 & C - 5).

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equip-ment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER,
TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class I Product
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Instructions for Care and Operation

The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:
1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.
Do not expose the computer to any shock or vibration.
Do not place it on an unstable surface.
Do not place anything heavy on the computer.
2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating element. This
is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.
Do not expose it to excessive heat or direct sunlight.
Do not leave it in a place where foreign matter or moisture may affect the system.
Don’t use or store the computer in a humid environment.
Do not place the computer on any surface that will block the Vents/Fan Intakes.
3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other strong
magnetic fields. These can hinder proper performance and damage your data.
4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget to save
your work. Remember to periodically save your data as data may be lost if the battery is depleted.
Do not turn off the power until you properly shut down all programs.
Do not turn off any peripheral devices when the computer is on.
Do not disassemble the computer by yourself.
Perform routine maintenance on your computer.
5. Take care when using peripheral devices.
Use only approved brands of peripherals.
Unplug the power cord before attaching peripheral devices.

Power Safety
The computer has specific power requirements:
• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply.
If you are unsure of your local power specifi-cations, consult your service representative or local power company.
• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety
feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install
one.
• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
• Make sure the socket and any extension cord(s) you use can support the total cur-rent load of all the connected devices.
• Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car
adapter).

Power Safety Warning
Before you undertake any upgrade procedures, make sure that you have turned off the power,
and disconnected all peripherals and cables (including telephone lines). It is advisable to also
remove your battery in order to prevent accidentally turning the machine on.

Do not plug in the power cord if you are wet.
Do not use the power cord if it is broken.
Do not place heavy objects on the power cord.
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the com-puter.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way.
Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may
possibly result in fire.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or
qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful
life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check
with your local solid waste officials for details in your area for recycling options or proper disposal.
Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by
the manufacturer. Discard used battery according to the manufacturer’s instructions.

Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer
to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then
refer servicing to qualified service personnel under any of the following con-ditions:
• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.



5PRESTIGIO VISCONTE 1450W

ENG

Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:
1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check
with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/
or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-
ware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container).
Putting a notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your
computer from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.

On the Road
In addition to the general safety and maintenance suggestions here keep these points in mind:
Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t
check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against
hard objects.
Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the computer, hard
disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the
devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note: Some airports also scan
luggage with these devices.
Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight. These
restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure.
Contents may shift and/or fall out when the compartment is opened.
Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery (ies) charged.
Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait
a few minutes before turning it on so that any moisture can evaporate.

Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints.
The following are some tips to reduce the strain:
• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your
forearms, wrists, and hands in a relaxed position.
• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
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• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Fre-quent and short breaks are better
than fewer and longer breaks.

Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.
• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

Quick Start Guide

System Startup

1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack on the right of the computer, then plug the AC power cord into an outlet,
and connect the AC power cord to the AC/DC adapter.
5. Raise the lid/LCD to a comfortable viewing angle, and press the power button to turn the computer “on”.
6. Adjust the LCD panel to a comfortable viewing angle.
7. The LED Power & Communication indicators show the power and battery status of the computer, and give notification
of e-mail received.

Shutdown
Please note that you should always shut your computer down by choosing the Turn Off
Computer command from the Start menu in Windows. This will help prevent hard disk or
system problems.
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Top View with LCD Panel Open

1. Optional Built-In PC Camera
2. LCD
3. Speaker
4. LED Status Indicators
5. Hot-Key Buttons
6. Power Button
7. Keyboard
8. TouchPad and Buttons
9. LED Power & Communication Indicators
10. Built-In Microphone

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices aboard aircraft is usually prohibited.
Make sure the module(s) are OFF if you are using the computer aboard aircraft.
Use the key combinations to toggle power to the WLAN/Bluetooth mod-ules, and check the
status indicator icon to see if the modules are powered on or not.
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LED Indicators

The two sets of LED indicators (LED Status Indicators and LED Power & Communication Indicators) on the computer
display helpful information about the current status of the computer.

Icon Color Description

Green Number Lock Activated (to activate press Fn & NumLk)

Green Caps Lock Activated

Green Scroll Lock Activated (to activate press Fn & ScrLk)

Green The Computer is On
Blinking Green The Computer is in Standby Mode
Orange The AC/DC Adapter is Plugged In & the Computer is Powered Off

Orange The AC/DC Adapter is Plugged In & the Battery is Charging
Blinking Orange The Battery has Reached Critically Low Power Status
Green The Battery is Fully Charged

Blinking Green New Mail Has Arrived

Green Hard Disk Activity

Green The WLAN Module is Powered On
Orange The Bluetooth Module is Powered On

Hot-Key Buttons & Keyboard

These buttons give instant access to the default Inter-net browser and e-mail program, and to a user-defined application,
with one quick button press. To use the “user-defined application Hot-Key Button”, you must install the driver.

Hot-Key Function

Activate the user specified application e.g. Microsoft Word or Excel

Activate the Default E-Mail Program

Activate the Default Internet Browser

The keyboard has an embedded numerical keypad for easy numeric data input, and features Function Keys to allow you
to change operational features instantly.
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Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system
will detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may
not work.

Function Keys

To use the function keys, press and hold the Fn key, then press the appropriate function key (F3 - F12 etc.).

Key Function

Fn  Function Fn Function Key

Fn + F3 Mute Toggle

Fn + F4 Sleep Toggle

Fn + F5 Decrease Audio Volume

Fn + F6 Increase Audio Volume

Fn + F7 Display Toggle

Fn + F8 Decrease LCD Brightness

Fn + F9 Increase LCD Brightness

Fn + F10 PC Camera Module Power Toggle

Fn + F11 Wireless LAN Module Power Toggle

Fn + F12 Bluetooth Module Power Toggle

Fn + NumLk Number Lock Toggle

Fn + ScrLk Scroll Lock Toggle

Special Characters
Some software applications allow the number-keys to be used with Alt to produce special characters. These special
characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard)
will not work. Make sure that NumLk is on.
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Front & Rear Views

1. LED Power & CommunicationIndicators
2. 4-in-1 Card Reader
3. External Monitor Port
4. S-Video-Out Port
5. RJ-11 Phone Jack
6. Security Lock Slot
7. Battery

4-in-1 Card Reader
The card reader allows you to use the most popular digital storage card formats: MMC (MultiMedia Card) / SD (Secure
Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro)

Left View

1. RJ-45 LAN Jack
2. Vent/Fan Intake
3. 2 * USB 2.0 Ports
4. S/PDIF-Out Jack
5. Line-In Jack
6. Mini-IEEE 1394 Port
7. PC Card Slot
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Right View

1. Headphone-Out Jack
2. Microphone-In Jack
3. 2 * USB 2.0 Ports
4. Optical Device Drive Bay
5. DC-In Jack

CD Emergency Eject
If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you
may push the end of a straightened paper clip into the emergency eject hole. Do not use a
sharpened pencil or similar object that may break and become lodged in the hole.
Media Warning
Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the
system to “crash”.

Changing DVD Regional Codes
Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/
CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties di-alogue box, and select the DVD Region
(tab) to bring up the control panel to allow you to adjust the regional code.
DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth
selection is permanent. This cannot be altered even if you change your operating system or you use the module in
another computer.

Bottom View

1. Vent/Fan Intake
2. Battery
3. Memory (RAM)/WLAN Module/CPU Cover
4. Hard Disk Cover
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Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the
battery at least once every 30 days or after about 20 partial discharges.

CPU
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any
way, may violate your warranty.
Overheating
To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

Windows XP Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are accessed
from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut
will usually be placed in the Start menu and/or the desktop. You can customize the look of the Start menu by right-
clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is
accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g.
power, video, network, audio etc.). Windows XP provides basic controls for many of the features, however many new
controls are added (or existing ones are enhanced) when you install the drivers. To see all controls it may be necessary
to toggle off Category View.

Video Features

Your computer will have built-in Intel (Intel GMA 900) on-board video. You can switch display devices, and configure
display options, from the Display Properties control panel in Windows as long as the appropriate video driver is installed.
To access Display Properties in Windows:
1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen area/resolution (1).
5. Click the arrow, and scroll to the preferred setting In Colors/Color quality (2).
6. You can also access Display Properties by right-clicking the desktop and scrolling down and clicking Properties. Click
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Settings (tab) and adjust as above.
7. Open the Display Properties control panel, and click Advanced (button) (3)
8. Click the Intel(R) Graphics Media Accelerator Driver tab, and click Graphics Properties (button) to make any video
adjustments you require.

Display Devices & Options

Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or TV as your display
device. A VGA monitor/Flat Panel Display connects to the external monitor port, a TV to the S-Video-Out Port. The
following display modes are available.

Intel Display Mode Description

Single Mode One of the connected displays is used as the display device

Intel(R) Dual Display Clone Mode Both connected displays output the same view and may be configured
independently

Extended Desktop Mode Both connected displays are treated as separate devices, and act as a virtual desktop

Intel Display Note
Note that the monitor is the default Primary display device in both Intel(R) Dual Display Clone
Mode and Extended Desktop Mode.
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Power Management Features

The Power Options control panel icon in Windows allows you to configure power management features for your
computer. You may conserve power through individual components such as the monitor or hard disk (by means of
Power Schemes), or you may use either Standby or Hibernate mode to conserve power throughout the system

The computer’s power button, sleep button (Fn + F4 key combination), and lid (closing the lid) may be set to send the
computer in to either Standby or Hibernate mode.

Power Saving and Performance
Power Schemes may have an affect on your computer performance.

Features & Components Overview

Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk can be taken out to accommodate other
2.5" parallel (PATA) hard disk drives with a height of 9.5 mm.
The hard disk is accessible from the bottom of your computer as seen below.
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Power Safety
Before attempting to access any of the internal components of your computer please ensure that the ma-chine is not
connected to the AC power, and that the machine is turned off. Also ensure that all peripheral cables, including phone
lines, are disconnected from the computer.

Optical (CD/DVD) Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the module you
purchased. The optical device is usually labeled “Drive D:” and may be used as a boot device if properly set in the BIOS.

Loading Discs
To insert a CD/DVD, press the open button (1) and carefully place a CD/DVD onto the disc tray with label-side facing up
(use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks”
and you are ready to start. The busy indicator (2) will light up while data is being accessed, or while an audio/video CD,
or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened pa-per clip into the
emergency eject hole (3) to open the tray.

Sound Volume Adjustment
How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume
icon on the taskbar to check the setting.

Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure
that the data stored on your CDs/ DVDs can be accessed.
Note the following:
• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject
If you need to manually eject a CD (e.g. due to an unexpected power interruption) you may
push the end of a straightened paper clip into the emergency eject hole. However please do
NOT use a sharpened pencil or similar object that may break and become lodged in the hole.
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Disk Eject Warning
Don’t try to remove a CD/DVD while the system is accessing it. This may cause the system to
“crash”.

DVD Regional Codes

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, the Philippines, Indonesia, Hong Kong

4 South & Central America, Mexico, Australia, New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China

4-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear
as a removable device, and can be ac-cessed in the same way as your hard disk (s). Make sure you install the PCM-CIA/Card
Reader Card driver.
• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS Pro (Memory Stick Pro)

Card Reader Cover
Make sure you keep the cover in the card reader when not is use. This will help prevent foreign objects and/or dust
getting in to the card reader.
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PC Card Slot
The computer is equipped with a PCMCIA 3.3V/5V slot for one type II PC-MCIA CardBus PC Card Slot. Make sure you install
the PCMCIA/Card Read-er Card driver.

Inserting and Removing PC Cards
• Align the PC Card with the slot and push it in until it locks into place.
• To remove a PC Card, simply press the eject button (1) next to the slot.

PC Card Slot Cover
Make sure you keep the cover in the PC Card slot when not is use. This will help prevent foreign objects and/or dust
getting in to the PC Card Slot.

Auto Mail Checker

After you have installed the driver for the Auto Mail Checker program you may then configure it to give you notification
when you receive new mail. You must be online to receive this notification (note that this program only supports the
POP3 protocol), and your default mail program does not need to be open.

The Auto Mail Checker appears as an icon  in the taskbar (if you do not see the icon in the taskbar go to Start >

Programs/All Programs > Auto Mail Checker > Auto Mail Checker). Right clicking on the icon will bring up the following
options menu. If you have not input your mail account data, then you will be prompted to do so.

Select Open to bring up the control panel for the program.
You may then configure the options for your mailserver, name, password, pro-gram and method(s) of notification.
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Note
Check with your Inter-net Service Provider, network administrator or Mail Service provid-er for
details on what to put on these pages.

Application Hot-Key

Application.exe
You will need to locate the actual application executable (.exe) file, not just the shortcut. To find
the application right-click its shortcut on the desktop and click Properties. Click the shortcut
(tab) and see where the executable file is located by clicking the Find Target (button).

The hot-key buttons give instant access to the default Internet browser and e-mail program, and to a user-defined

application, with one quick button press. To configure a program to open when the application hot-key  is

pressed (Windows Media Player is the default program), follow the instructions below.

1. Right click the Hot-Key driver icon  in the taskbar.

2. Select Setup from the menu, scroll to Application 1 and press Enter.

3. An Open dialog box will appear on the screen.

4. Browse to the directory where the desired application.exe (see the sidebar) program exists.
5. Double-Click on the program file or choose Open.

TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the
USB ports. The TouchPad buttons function in much the same way as a two-button mouse. The central button may be
configured to function as you require.

Configuring the TouchPad and Buttons
Once you have installed the TouchPad driver you can configure the functions by double-clicking the TouchPad driver
icon on the taskbar, or by going to the Mouse control panel in Windows (Start menu and point to Settings and click
Control Panel, then double-click the Mouse icon). In Windows XP the Mouse control panel is in the Printers and Other
Hardware Category.
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Mouse Driver
If you are using an external mouse your operating system may be able to auto-configure your mouse during its
installation or only enable its basic functions. Be sure to check the device’s user documentation for details.

Audio Features

You can configure the audio options on your computer from the Sounds and Audio Devices
Windows control panel, or from the Sound Effect Manager icon in the taskbar/control panel (this will bring up the
Realtek Audio Configuration menus). The volume may also be adjusted by means of the Fn + F5/F6 key combination.

Sound Volume Adjustment
How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume
icon on the taskbar to check the setting.

8 Channel Sound Support
If you wish to configure your system for 8 channel sound support, then the fol-lowing ports should be used as outputs.
Double-click the appropriate icon (e.g. ) to bring up the “Connected device:” dialog box to configure the output port.
• Side Speaker Out - Connect to S/PDIF Out
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• Center/Subwoofer Speaker Out - Connect to Microphone In
• Front Speaker Out - Connect to Speaker/Headphone Out
• Rear Speaker Out - Connect to Line In

Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer, however it
is always best to refer to the printer manual for specific instructions and configuration options.

USB Printer
Most current printers have a USB interface connection. You may use any one of the ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen
instructions.

Parallel Printer
After setting up the printer attach the parallel cable to the printer.
Connect the printer’s parallel cable to the Parallel to USB converter, and then plug the converter into the USB port.
Turn ON the printer, then turn ON the computer.
Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen
instructions.

Power Management Overview

Advanced Configuration and Power Interface
The ACPI interface provides the computer with enhanced power saving techniques and gives the operating system (OS)
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direct control over the power and thermal states of devices and processors. For example, it enables the OS to set devices
into low-power states based on user settings and information from applications. ACPI is fully supported in Windows
XP/Windows XP MCE.

OS Note
Power management functions will vary slightly depending on your operating system. For more
information it is best to refer to the user’s manual of your operating system.
Note: All pictures used on the following pages are from the Windows XP OS.

The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer
and its components.
1. Attach the AC/DC adapter to the DC-in jack on the right of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter (see sidebar if you
are using the optional Port Replicator).
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery
life varies depending on the applications and the configuration you’re using. To increase battery life, let the battery
discharge completely before recharging.
We recommend that you do not remove the battery.

Port Replicator AC/ DC Adapter
You will be provided with a 90W AC/DC adapter if you purchase the port replicator option. If
you are using the computer with the Port Replicator, then you must use the 90W AC/DC adapter
to power the port replicator and computer (DO NOT USE the computer’s 65W AC/DC adapter to
power the Port Replicator).

Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.
When the computer is on, you can use the power button as a Standby/Hiber-nate/Shutdown hot-key button when it
is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the com-puter
down). Use Power Options in the Windows control panel to configure this feature.

Forced Off
If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or
longer, to force the system to turn itself off.
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Power Button as Standby or Hibernate Button
If you are using a fully ACPI-compliant OS, (such as Windows XP) you can use the OS’s “Power Options” control panel
to set the power button to send the system into Standby or Hibernate mode.

Shutdown
Note that you should always shut your computer down by choosing the Turn Off Computer command from the Start
menu in Windows. This will help prevent hard disk or system problems.

Power Schemes

You can set your computer to conserve power through individual components by means of Power Schemes. You can
also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the computer’s hard
disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or
writes data, the hard disk motor will be turned back on). The schemes may also be set to set a specified time for the system
to enter Standby or Hibernate modes.

Resuming Operation
The system can resume from Monitor or Hard Disk Standby by pressing a key on the keyboard, the Sleep/Resume key
combination (Fn + F4), or power button.

Each Windows Power Scheme will also adjust the processor performance of your machine in order to save power. This
is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).
Choose the Home/Office Desk scheme for maximum performance when the computer is powered from an AC power
source. Choose the Max Battery scheme (bear in mind that this scheme may slow down the overall perfor-mance of the
computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.
Windows will use Porta-ble/Laptop as the default scheme.
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System Power Options

You can use the system power options to stop the computer’s operation and restart where you left off. This system
features Standby and Hibernate sleep mode levels (Hibernate mode will need to be enabled by clicking the option in
the Hibernate tab in the Power Options control panel).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn
it on. Their main difference is:
When you come back from hibernation, you can return to where you last left off (what was on your desktop) without
reopening the application(s) and file(s) you last used.
You can use either method depending on your needs.

Standby Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the sys-tem on standby instead of in hibernation.
It takes a longer time to wake up the system from Hibernate mode than from Standby mode.

Standby
Standby saves the least amount of power, but takes the shortest time to return to full operation. During Standby the hard
disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memo-ry. When
you are not using your computer for a certain length of time, which you specify in the operating system, it will enter
Standby mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although
it saves the most power it takes the longest time to return to full operation. You can set your computer to au-tomatically
enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the
Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power
button.

System Resume
The system can resume from Standby mode by:
• Pressing the power button
• An alarm resume that is enabled and expires
• An incoming call received on the modem (if enabled)
• Network card activity (if enabled)
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Configuring the Power Button

The power button may be set to send the computer in to either Standby or Hibernate mode. In Standby mode, the LED
will flash green. In Hibernate mode the LED will be off (battery) or orange (AC/DC adapter). If you are in a power saving
mode set to save power through individual components (e.g. hard disk, monitor), the LED will remain green.

Sleep Button
You may also configure the Sleep/Resume key combination (Fn + F4) from the menu. In Windows this is referred to as
the Sleep button.

Battery Information
Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery.

Battery Life
Your computer’s battery life is dependent upon many factors, including the programs you are running, and peripheral
devices attached. Power Options (you may set low battery Alarms and actions, and check the Power Meter from the
Power Options control panel), and settings in the OS will help pro-long the battery life if configured appropriately.
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Low Battery Warning
When the battery is critically low, immediately connect the AC/ DC adapter to the computer or
save your work, otherwise, the unsaved data will be lost when the power is depleted.

Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully
discharge and recharge the battery at least once every 30 days.
We recommend that you do not remove the battery yourself.

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If
the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is
turned off but plugged into an electrical outlet, battery charge time is less.

Conserving Battery Power
To conserve battery power:
Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is
not powered by the AC/DC adapter.
Close modem or communication applications when they are not being used.
Remove any unused PC Cards from the computer (PC Cards quickly use up battery power even if the system enters sleep
mode).
Disconnect any unnecessary external devices.

Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning
Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do not
recommend using it any further, as even if the computer continues to work with a damaged
battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended
that you replace your computer battery every two years.

Battery FAQ

Caution
Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent
type recommended by the manufacturer. Discard used battery according to the manufacturer’s
instructions.

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by yourself
even when you see a message that in-dicates the battery is critically low, just let the computer use up all of the bat-tery
power and shut down on its own. Disable the Power Options functions in the Control Panel, especially any Alarms and
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Schemes. As the bat-tery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or af-ter about 20 partial discharges.

Drivers & Utilities

What to Install
The Device Drivers & Utilities + User’s Manual CD-ROM contains the drivers and utilities neces-sary for the proper opera-
tion of the computer. (The Wireless LAN, optional Bluetooth, optional PC Camera and optional Port Replicator module
drivers are on separate CD-ROMs supplied.) It is very important that the drivers are installed in the order indicated.

Navigate (Browse..) to D:
You will notice that many of the instructions for driver installation require you to “Navigate (Browse) to D:”. We assume
that you will install all drivers and utilities from the built-in CD device and it is assigned to “Drive D:”. (In addition, all file
extensions can be seen.)
In this case “D:” is the drive specified for your CD device. Not all computers are setup the same way, and some computers
have the CD listed under a different drive letter - e.g. if you have two hard drives (or hard disk partitions) one may be
designated as “Drive C:” and the other as “Drive D:”. In this case the CD device may be designated as “Drive E:” - Please make
sure you are actually navigating to the correct drive letter for the CD device.
When you click the Browse (button) after clicking Run in the Start menu you will see the “Look in:” dialog box at the
top of the Browse window. Click the scroll button to navigate to My Computer to display the devices and drive letters.

Service Packs

Check the warnings on the following pages regard-ing installation of the appropriate Service Pack for your Windows
OS. Make sure you have installed the appropriate Service Pack before installing all the drivers.

Service Pack Installed
To see which Service Pack is currently installed on your computer go to the General tab of the System control panel.
Right-click the My Computer icon on the desktop or in the Start menu and select Properties. The Service Pack currently
installed on your system will be listed under the “System:” heading. (If no Service Pack information is listed, then no
Service Pack is installed.)

Windows XP Service Pack 2
Make sure you install Windows XP Service Pack 2 (or a Windows XP version which includes Service Pack 2) before
installing any drivers. Service Pack 2 includes support for USB 2.0.
If you have upgraded the system by installing Service Pack 2 (i.e. your Windows XP version does not include Service Pack
2) then follow these instructions:
1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
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2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click the Hardware (tab) > Device Manager (button).
4. Click “+” next to Other Devices (if its sub-items are not shown).
5. Right-click Universal Serial Bus (USB) Controller and select Uninstall > OK (if you don’t see the item then there is no
need to take any further action).
6. Restart the computer and it will find the USB 2.0 controller.

Authorized Driver Message
If you receive a message telling you that the driver you are installing is not authorized (Digital Signature Not Found),
just click Yes or Continue Anyway to ignore the message and continue the installation procedure.
You will receive this message in cases where the driver has been released after the version of Windows you are currently
using. All the drivers pro-vided will have already received certification for Windows.

Version Conflict Message
During driver installation if you encounter any “file version conflict” message, please click Yes to choose to keep the
existing (newer) version.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver.To do this go to the
Control Panel in the Windows OS and double-click the Add/Remove Programs item. If you see the individual driver listed
(if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the comput-er). Go to the
appropriate section of the manual to complete the update/reinstall procedure for the driver in question.
If the driver is not listed in the Add/Remove Programs item:
1. Click Start (menu), point to Settings and click Control Panel (or click Start > Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver tab) and follow the on screen prompts.

Driver Installation

Insert the Device Drivers & Utilities + User’s Manual CD-ROM and the NoteBook Driver Installation application will run
automatically. If you want to install the driver manually see “Manual Driver Installation” below.
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1. Check the driver installation right order (the drivers must be installed in this order) which is the same as that listed in
the Drivers Installer menu below.
2. Click to select the driver you wish to install, after installing each driver it will become grayed out (if you need to reinstall
any driver, click the Unlock button).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Driver Installation
1. Install the appropriate Service Pack for WinXP
2. Chipset
3. Video
4. Audio
5. LAN
6. Modem
7. TouchPad
8. PCMCIA/Card Reader
9. Hot-Key
10. AutoMail (Manual Driver Installation Only)
11. Intel Wireless LAN
12. Bluetooth
13. PC Camera
14. Port Replicator Serial Port
15. Port Replicator Network (LAN) Port

Driver Installation Procedure
This section covers driver and utility installation in-structions for Windows XP Home & Professional.

New Hardware Found
If you see the message “New Hardware Found” (Found New Hardware Wizard) during the in-stallation procedure
(other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation
procedure as directed.

Service Pack Installation
Make sure you install the appropriate service pack for your operating system before installing any drivers.
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Manual Driver Installation
If you wish to install the drivers manually, click the Exit button to quit the Drivers Installer applica-tion, then follow the
manual installation procedure for each driver. The manual installation procedure begins with instructions on how to
browse to the executable file; “Click Start (menu) > Run..”.

New Hardware Found
If you see the message “New Hardware Found” (Found New Hardware Wizard) during the in-stallation procedure
(other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation
procedure as directed.

Chipset (WinXP)

1. Click 1.Install Chipset Driver > Yes from the Drivers Installer menu.
OR
Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\Chipset\Setup.exe and click OK.
2. Click Next > Yes > Next.
3. Click Finish to restart the computer.

Video (WinXP)

1. Click 2.Install Video Driver > Yes from the Drivers Installer menu.
OR
Navigate (Browse..) to D:\Drivers\Video\Setup.exe and click OK.
2. Click Next > Yes.
3. Click Finish to restart the computer.

Audio (WinXP)

1. Click 3.Install Audio Driver > Yes from the Drivers Installer menu.
OR
Navigate (Browse..) to D:\Drivers\Audio\Setup.exe and click OK.
2. Click Next.
3. Click Finish to restart the computer.
4. When the computer restarts click Cancel if the The Found New Hardware Wizard appears (click Continue Anyway if
asked if you want to continue at any time).
5. Click Yes to restart the computer (click Can-cel if The Found New Hardware Wizard appears after restart).

LAN (WinXP)

1. .Click 4.Install LAN Driver > Yes from the Drivers Installer menu.
OR
Click Start (menu) > Run... and navigate (Browse...) to D:\Drivers\LAN\Setup.exe and click OK.
2. To continue click Next.
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3. Click Finish.
4. The network settings can now be configured.

Modem (WinXP)
1. Click 5.Install Modem Driver > Yes from the Drivers Installer menu.
OR
Click Start (menu) > Run... and navigate (Browse...) to D:\Drivers\Modem\ssetup.exe and click OK (click Continue Any-
way if asked if you want to continue at any time).
2. Click OK.
3. The modem is ready for dial-up configuretion.

Modem Country Selection
Be sure to check if the modem country selection is appropriate for you (Control Panel > Phone
and Modem Options).

TouchPad (WinXP)

1. Click 6.Install TouchPad Driver > Yes from the Drivers Installer menu.
OR
Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\TouchPad\SETUP.EXE and click OK.
2. Click Next > Next (click Continue Anyway if asked if you want to continue at any time).
3. Click Finish to restart the computer.

PCMCIA/Card Reader (WinXP)

1. Click 7.Install PCMCIA Driver > Yes from the Drivers Installer menu.
OR
Click Start (menu) > Run... and navigate (Browse...) to D:\Drivers\PCMCIA\Setup.exe and click OK.
2. Click Next > Next.
3. Click Finish to restart the computer.

Hot-Key (WinXP)

1. Click 8.Install Hotkey Utility > Yes from the Drivers Installer menu.
OR
Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\Hotkey\Setup.exe and click OK.
2. Choose the language you prefer, and click OK.
3. Click Next.
4. Click Finish to restart your computer.

AutoMail (WinXP)

The AutoMail Driver must be installed manually as per the instructions below:
1. Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\AUTOMAIL\SETUP.EXEand click OK.
2. To continue click Next > Next > Finish.
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Wireless LAN

Intel PRO/Wireless Mini-PCI WLAN Module

If you have included an Intel PRO/Wireless 2915ABG (802.11a/b/g) Mini-PCI WLAN module in your purchase option,
you will have the appropriate software CD provided for your module.
Before installing the Intel PRO/Wireless 2915ABG Mini-PCI WLAN driver, make sure that the Wireless LAN module is on
(the WLAN LED will be green). Use the Fn + F11 key combination to toggle power to the Wireless LAN module.
To get help on the network settings you can view the User Guide from the Intel PRO CD-ROM.

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices aboard aircraft is usually prohibited.
Make sure the module(s) are OFF if you are using the computer aboard aircraft.
Use the Fn + F12 key combination to toggle power to the optional Bluetooth module, and
check the indicator to see if the module(s) is powered on or not.

Intel WLAN Driver Installation
1. Make sure the module is powered on, then insert the Intel PROSet/ Wireless CD-ROM into the CD/DVD drive.
2. Click Install Software (button).
3. Click the button to accept the license and click Next > Next > OK.
4. Click OK to complete the installation.
5. You can configure the settings by going to the Intel (R) PROSetWireless control panel (Start > Programs/All Programs
> Intel PROSet Wireless), or by double-clicking the taskbar icon.
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Bluetooth Module

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices aboard aircraft is usually prohibited.
Make sure the module(s) are OFF if you are using the computer aboard aircraft.
Use the Fn + F12 key combination to toggle power to the optional Bluetooth module, and
check the indicator to see if the module(s) is powered on or not.

If you have included a Bluetooth module in your purchase option, you will have the appropriate software CD provided
for your module.
Before installing the Bluetooth driver, make sure that the optional Bluetooth module is on (the Bluetooth LED will be
orange). Use the Fn + F12 key combination to toggle power to the Bluetooth module. Make sure you install the drivers.

Bluetooth Driver Installation
1. Make sure the module is powered on, then insert the Bluetooth CD-ROM into the CD/DVD drive.
2. The program will run automatically.
3. Choose the language you prefer, and click OK.
4. Click Next > Yes > Next.
5. Click Finish to restart the computer.
6. Click OK when the Welcome to Bluetooth screen appears on restart.
7. You can configure the settings by going to the IVT CorporationBlueSoleil - Main Window control panel (Start >
Programs/All Programs > IVT BlueSoleil), or by clicking the taskbar icon.

PC Camera

If you have included an PC Camera module in your purchase option, you will have the appropriate software CD provided
for your module.
Before installing the PC Camera driver, make sure that the optional PC Cam-era is on. Use the Fn + F10 key combination
to toggle power to the PC Camera module. Make sure you install the drivers.
After installing the driver you can run the application software by going to the CMM PC Camera item in the Start >
Programs/All Programs menu and selecting the BisonCap program.

Taking Still Pictures
Double-click the My Computer icon on the desktop, or go the Start menu and point to My
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Computer, then click it.
Double-click the BisonCam, NB Pro icon.
Click Take a new picture in the Camera Tasks box.

Latest PC Camera Driver Information
Check the PC Camera CD, and any accompanying insert pages, for the latest updated information on the PC Camera driver,
which may override the information provided here.

Sertek PC Camera Driver Installation (WinXP)
1. Press the Fn + F10 key combination to power on the PC Camera module (click Cancel if you see a “New Hardware
Found” message).
2. Insert the PC Camera CD-ROM into the CD/DVD drive.
3. The program will run automatically.
4. Click Install Products.
5. Choose the language you prefer and click OK.
6. Click Next (click Continue Anyway if asked if you want to continue).
7. When the Found New Hardware Wizard appears click the No, not this time button, and click Next.
8. Select install the software automatically (Recommended) and click Next (click Continue Anyway if asked if you want
to continue).
9. Click Finish (in the Found New Hardware Wizard) > Finish (in the InstallShield Wizard) to restart the computer.
10. Run the BisonCap application program from the shortcut on the desktop, or from the BisonCam item in the Start
> Programs/All Programs menu (if the hardware is turned off use the Fn + F10 key combination to turn it on again).

PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.
1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the
Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
2. Click Advanced in the Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select Realtek HD Audio input from the Mixer Device menu.
5. Click Mic Volume (check box) if it is not checked, then click OK.
6. Make sure the Select (check box) in the Recording Control panel, under the Mic Volume section, is checked (boost the
volume as high as it will go).
7. Close the window, then click OK.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Realtek HD Audio input (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
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BisonCap
BisonCap is a video viewer useful for general purpose video viewing and test-ing, and can capture video files to .avi
format.
1. Run the BisonCap program from the Start > Programs/All Programs > BisonCam menu (it is recommended that you
set the capture file before the capture process -see Set Capture File below).
2. Go to the Capture menu heading and select Start Capture.
3. On the first run of the program (if you have not set the captured file) you will be asked to choose a file name and size
(see Pre-Allocating File Space) for the captured file. Click Start Capture again.

Pre-Allocating File Space
You may pre-allocate the file size for the capture file in the BisonCap program. You can choose
to ignore this by clicking Cancel.
Pre-allocating space on the hard disk can improve the capture quality (particularly of large
capture files), by reducing the amount of work the hard disk has to do in finding space for the
video data as it is being captured.
You may find it helpful to defragment the HDD before capture.

4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video As..., choose a file name and location, then
click Open (you can view the file using the Windows Media Player).

Set Capture File
In the BisonCap program you will only be asked to set the capture file name on the first run of the program. When you



35PRESTIGIO VISCONTE 1450W

ENG

run the program the next time the file will automatically be overwritten with the newly captured file. To avoid overwrit-
ing files you can go to the Set Capture File.. option in the File menu, and set the file name and location before capture.
Set the name and location then click Open (you can choose Cancel to ignore the file size if prompted).

Eliminating Screen Flicker
If you find that the video screen in the BisonCap program is flickering, you can try to adjust the setting in the Video
Capture Filter options.
1. Run the BisonCap program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Intel Video Driver Controls

Intel Video Driver Installation
Make sure you install all the drivers. Instructions for installing the video driver are repeated below.
1. Click 2.Install Video Driver > Yes from the Drivers Installer menu.
OR
Navigate (Browse..) to D:\Drivers\Video\Setup.exe and click OK.
2. Click Next > Yes.
3. Click Finish to restart the computer.

Dynamic Video Memory Technology
Intel® DVMT 3.0 automatically and dynamically allocates as much (up to 128MB) system memory (RAM) as needed to
the video system (the video driver must be installed. DVMT returns whatever memory is no longer needed to the
operating system.
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DVMT Notes
DVMT is not user-configurable.
DVMT is not local video memory.
DVMT will not function in MS-DOS. DOS uses the legacy memory indicated.

Information Tab
The information tab in Graphics Properties in the intel(R) Graphics Media Accelerator Driver (tab) lists details of your
computer’s memory etc.

Intel Graphics Properties
More advanced video configuration options are provided by the Intel(R) Graphics Media Accelerator Driver.
1. Open Display Properties.
2. Click the Intel(R)... tab and click Graphics Properties (button).
3. You can also access Graphics Properties from the Windows Intel(R) GMA Driver for Mobile control panel.
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Taskbar Icon
You can also access the controller properties from the taskbar. Click on the icon to bring up the
menu and scroll to Graphics Options > Graphics Properties.
If you cannot see the tray icon go to the Intel(R) Graphics Media Accelerator Driver tab (in the
Display Properties > Advanced options) and click the “Show Tray Icon” tickbox.

You may make changes to the Devices, Color, Schemes, Hot Keys by clicking the appropriate tab and adjusting the setting,
then clicking OK. The Informa-tion and Open GL tabs display useful information about the graphics proper-ties of the
computer, and the Support item in the Information tab has weblinks to the latest information on the Intel Website.

Intel Graphics Properties
Note that the Graphics Properties control panel is entitled Mobile Intel(R) 915GM/GMS, 910GML Express Chipset Family.

Schemes
Use Schemes to configure quick settings for applications which require specific resolution and color settings in order
to run properly e.g. games, multi-media programs. To set the schemes:
1. Go to the Graphics Properties control panel.
2. Configure your display configuration, resolution etc. as per your requirements, from Devices (tab).
3. Click on Schemes (tab).
4. Click New (button), and type a name for the scheme then click OK.
5. If you want to automatically launch an application when running the scheme click on Browse (button).
6. Browse to the executable file for the application you want to set a scheme for (see sidebar), and click Open to select
it.
7. Click Save to save the settings (you can click in the “Reset On Exit” box to return to your original settings when you
exit the program).
8. Click OK to exit the program.

Application.exe
You will need to locate the actual application executable (.exe) file, not just the shortcut.
To find the application right-click its shortcut on the desktop click Properties. Click the Shortcut
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(tab) and see where the executable file is located by clicking the Find Target (button). Note the
location and you will then be able to browse to this file.

Display Devices
Besides the built-in LCD, you can also use an external monitor/flat panel dis-play or TV as your display device. The
following are the display options:
1. The built-in LCD.
2. An external monitor connected to the external monitor port.
3. A flat panel display connected to the external monitor port.
4. A TV connected to the S-Video-Out Port.

Function Key Combination
You can use the Fn + F7 key combination to toggle through the display options:
Notebook Only
External Display Only
Notebook + External Display
Make sure you give the displays enough time to refresh.

Television Display Warning
After you have connected a TV as a Display device for the first time, the Television icon will
appear in the Devices tab permanently thereafter (whether or not as television is connected to
the S-Video-Out Port).
If you select the Television as the single display device when no TV is connected to the S-Video-
Out Port, the screen may appear blank. If this happens use the Fn + F7 key combination to
toggle through the display options until the display reappears on the notebook screen.

Attaching Other Displays
If you prefer to use a monitor or flat panel display, connect it to the external monitor port on the left of the computer.
1. Attach your external monitor to the external monitor port, and turn it on.
2. Go to the Graphics Properties control panel and click Devices (tab).
3. Choose the display option from the list on the left.
4. Choose which attached device will be Primary or Secondary.
5. Click Apply (and OK to confirm the settings change) and OK (button).
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Intel Display Note
Note that the monitor is the default Primary display device in both Intel(R) Dual Display Clone
Mode and Extended Desktop Mode.

Display Modes

Single Display
Only one of your attached displays is used.

Intel(R) Dual Display Clone
This mode will drive multiple displays with the same content. Each device may be configured independently for different
resolutions, refresh rates, color quality etc. Use this feature to display the screen through a projector for a pre-sentation.

Extended Desktop
This mode allows a desktop to span multiple displays and acts as a large work-space. This creates a lot more screen area
for display. Use the Display Properties control panel to drag the monitors to match the physical arrangement you wish
to use, or you may also use the Extended Desktop Settings control panel tab in Graphics Properties to configure the
relative size and position.

To Enable Intel(R) Dual Display Clone Mode
1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out Port), and turn it on.
2. Go to the Graphics Properties control panel and click Devices (tab).
3. Click Intel(R) Dual Display Clone (icon).
4. Choose which attached device will be Primary or Secondary.
5. Adjust the settings by clicking the Display Settings (tab) if necessary.
6. Click Apply (and OK to confirm the settings change) and OK (button).

To Enable Extended Desktop Mode:
1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out Port), and turn it on.
2. Go tothe Graphics Properties control panel (see “Intel Graphics Properties” on page B - 3) and click Devices (tab).
3. Click Extended Desktop (icon).
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4. Choose which attached device will be Primary or Secondary.
5. Adjust the settings by clicking the Device Settings (button) if necessary.
6. Click Apply (and OK to confirm the settings change) and OK (button).

Click the appropriate monitor icon and drag it to match the physical ar-rangement you wish to use (e.g. the secondary
display may be extended left/right/above/below  the primary display).
Click Display Settings to make any adjustments required.
You can also enable the Extended Desktop mode from the Display Properties control panel

Display Settings Extended Desktop
You can have different Colors, Screen Area and Monitor Refresh Rates for each display device provided your monitor can
support them.
You can drag the monitor icons to match the physical layout of your displays. Icons and programs may also be dragged
between the displays.

To Enable Extended Desktop (Display Properties)
1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out Port), and turn it on.
2. Click Start, point to Settings (or click Control Panel) and click Control Panel (if you are in Category View choose
Appearance and Themes).
3. Double-click Display (icon).
4. In the Display Properties dialog box, click Settings (tab).
5. Click the monitor icon (e.g. (2)), and make sure you have checked “Extendmy Windows desktop onto this monitor.”
and click Apply.
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Click the appropriate monitor icon (e.g. (2)) to be able to select the option to extend the desktop on to it.
In this example the Primary monitor (1) is on the left, the secondary display (2) is on the right.

TV Settings
If you are using a TV as a display device you may adjust the settings as follows:
1. Attach your TV to the S-Video-Out Port and turn it on.
2. Go to the Graphics Properties control panel and click Devices (tab).
3. Choose the television as one of your display devices.
4. Adjust the settings by clicking the Display Settings (button).
5. Choose the appropriate TV system from Video Standard dropbox.
6. Click the TV Settings (button) if the TV is set to be the only display device (click the Television icon and click Apply to
set the TV as the only display device).

Port Replicator

If you have included the Port Replicator in your purchase option, the device will allow you to easily attach the notebook
to standard, non-portable devices e.g. a printer or monitor.

Port Replicator AC/DC Adapter
You will be provided with a 90W AC/DC adapter if you purchase the port replicator option.
If you are using the computer with the Port Replicator, then you must use the 90W AC/DC
adapter to power the port replicator and computer (DO NOT USE the computer’s 65W AC/DC
adapter to power the Port Replicator).

You will be provided with a CD including drivers for the serial (COM) port, and for the network (LAN) jack.

1. 4 * USB Ports
2. RJ-45 LAN Jack
3. Parallel (printer) Port
4. Serial Port
5. External Monitor Port
6. Port Replicator DC-In
7. Port Replicator Power Cable (to computer’s DC-In)
8. External Monitor Cable (to computer’s External Monitor Port)
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Port Replicator Setup Instructions:
1. Turn the computer OFF.
2. Attach the Port Replicator’s external monitor cable to the external monitor port on the rear of the computer.
3. Attach the Port Replicator’s power cable to the DC-In jack on the right of the computer.
4. Attach the Port Replicator’s (90W) AC/DC adapter unit to the DC-In jack on the left side of the Port Replicator (DO NOT
USE THE COMPUTER’S POWER SUPPLY UNIT TO POWER THE PORT REPLICATOR).
5. Turn ON the computer.
6. Install the serial port driver.
7. Install the LAN driver.
8. Plug in any devices you require into the appropriate Port Replicator port/jack (note certain devices may require their
own drivers, and/or the computer to restart).

Port Replicator Serial (COM) Port Driver (WinXP)
1. Insert the provided Port Replicator CD into the computer’s CD/DVD drive.
2. Click Start (menu) > Run... and navigate (Browse...) toD:\PL-2303 Driver Installer\PL-2303 Driver Installer.exe and click
OK.
3. Click Next > Finish.

Port Replicator Network (LAN) Driver (WinXP)
1. Attach the Port Replicator as per the instructions in “Port Replicator”.
2. Insert the provided Port Replicator CD into the computer’s CD/DVD drive.
3. If you can see the My Computer icon on the desktop (if you cannot see the My Computer icon go to step 4) click on
it once to select it, then right-click it to make the sub-menu appear and scroll down to Properties and click on it (go to
step 5).
4. If you cannot see the My Computer icon Start (menu), then point to (but don’t click it, just highlight it) My Computer.
Right-click it to make the sub-menu appear and scroll down to Properties and click on it (go to step 5).
5. Click Hardware (tab), then click Device Manager (button).
6. Click “+” next to Other devices (if its sub-menu items are not shown).
7. Double-click AX88772 and click Driver (tab).
8. Click Update Driver (button).
9. Select “No, not this time” then click Next.
10. When the Hardware Update Wizard appears, click “Install from a list or specific location (Advanced)” then click Next.
11. Select “Search for the best driver in these driver in these locations.” and select ONLY “include this location in the
search:”.
12. Navigate (Browse...) to D:\LAN and click OK > Next.
13. Click Finish and close the open windows.
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Troubleshooting Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try
to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate
every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you
have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your
service representative. You should also make a record of what happened and what remedies you tried.
Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this
section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few
minutes and then rebooting. You will lose any unsaved data, but it may start work-ing again. Then call your service
representative.

Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer appears
not to be working.
 Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it
is actually working. Check the LED Power & Communication Indicators to see the computer’s power status.
 Connections - Check all the cables to make sure that there are no loose connections anywhere.
 Power Savings - Make sure that the system is not in Hibernate or Standby mode by pressing the keys configured in your
Power Options, the Fn + F4 key combination, or power button to wake-up the system.
 Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness.
 Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.
 Boot Drive - Make sure there are no floppy disks in any connected drive when you start up your machine (this is a
common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other
media. Press any key to restart”).

Backup and General Maintenance
 Always backup your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to
note the serial numbers if you are storing them out of their original cases, e.g. in a CD wallet.
 Run maintenance programs on your hard disk and OS as often as you can. You may schedule these programs to run at
times when you are not using your computer. You can use those that are provided free with your OS, or buy the more
powerful dedicated programs to do so.
 Write down your passwords and keep them safe (away from your computer). This is especially impor-tant if you choose
to use a Supervisor password for the BIOS.
 Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your
warranty.

Viruses
 Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for)
up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause
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you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable
directly from the internet.
 Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attach-
ments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail
attachments. Note: You should also beware of files from people you know as the virus may have infected an address book
and been automatically forwarded without the person’s knowledge.
 Keep a “Boot Floppy Disk” or “Bootable CD-ROM” (this disk provides basic information which allows you to startup your
computer) handy. You may refer to your OS’s documentation for instruc-tions on how to make one, and many Anti-Virus
programs will also provide such a disk (or at least instructions on how to make one).

Upgrading and Adding New Hardware/Software
 Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing,
otherwise you will risk severely damaging your system.
 Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are
doing.
 Read the documentation. We can assume, since you are reading this that you are looking at the com-puter’s manual,
but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of
new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay
particular attention to files entitled “READ ME” or “READ ME FIRST”.
 When installing a new device always make sure the device is powered on, and in many cases you will need to restart the
computer. Always check that all the cables are correctly connected.
 Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available
to download from vendor’s websites).
 Thoroughly check any recent changes you made to your system as these changes may affect one or more system
components, or software programs. If possible, go back and undo the change you just made and see if the problem still
occurs.
 Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found;
Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be
difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all
the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where nec-
essary) will often find the source of a problem, although this may be time consuming.

Problems and Solutions
You turned on the power but it doesn’t work -

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present and seated properly (the
design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.
The Audio “DJ” player is on. Press the Audio “DJ” power button to turn the player off, then press the computer’s power
button to power on the computer.

The battery LED power indicator is blinking orange -
Low Battery. Plug in the DC power source. If the computer doesn’t start up immediately, turn it off then on again.

You are losing battery power too quickly -
The system is using too much power. If your OS has a Power Options scheme check its settings. You may also be using
a PC Card device that is drawing a lot of power.
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Actual battery operating time is shorter than expected -
The battery has not been fully discharged before being recharged. Make sure the battery is fully discharged and recharge
it completely before reusing.
Power Options have been disabled. Go to the Control Panel in Windows and re-enable the options.
A peripheral device or PC Card is consuming a lot of power. Turn off the unused device to save power.

The computer feels too hot -
Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this doesn’t cool it down, put
the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface. Make
sure you’re using the correct adapter.
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container).
Putting a notebook which is powered on in a travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen -
The system is in a power saving mode. Toggle the sleep/resume key combination, Fn + F4.
The screen controls need to be adjusted. Toggle the screen control key combinations Fn + F8/F9. If you’re connected
to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness
and contrast controls.
The computer is set for a different display. Toggle the screen display key combination, Fn + F7. If an external monitor is
connected, turn it on.
The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external monitor I have plugged in and powered on -
You haven’t installed the video driver and configured it appropriately from the Control Panel.

You forget the boot password -
If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for
help.

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this
could be serious. If you cannot remember your boot password you must contact your vendor
and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume is very low -
The volume might be set too low. Check the volume control in the Volume Control Panel in the Windows taskbar, or use
the key combination Fn + F5 and F6 to adjust.

The compact disc cannot be read -
The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc tray will not open when there is a disc in the tray -
The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject hole.

The DVD regional codes can no longer be changed -
The code has been changed the maximum 5 times.
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The Audio “DJ” CD Player will not turn on (nothing appears on the LCD of the player) -
The computer is turned ON. Check your computer is not turned on (or running in a power saving mode), and if it is, then
shut it down and press the ON/OFF switch on the Audio “DJ” Player.

Unwelcome numbers appear when typing -
If the LED CAPS is lit, then Num Lock is turned ON.

The system freezes or the screen goes dark -
The system’s power saving features have timed-out. Use the AC/DC adapter, press the sleep (Fn + F4) key combination,
or press the power button if no LEDs are lit.

The system never goes into a power saving mode -
Power Options features are not enabled. Go to the Windows Power Options menu and enable the features you prefer.
Make sure you have enabled Hibernate mode from the control panel.

The Wireless LAN/ Bluetooth/ PC Camera modules cannot be detected -
The modules are off. Check the appropriate LED indicator to see if the WLAN/Bluetooth/ PC Camera module is on or off.
If the LED indicator is off, then press the Fn + F11 (WLAN), Fn + F12 (Bluetooth) or Fn + F10 (PC Camera) key combination(s)
in order to enable the modules.

The Wireless LAN/ Bluetooth/ PC Camera modules cannot be configured -
The driver(s) for the module(s) have not been installed. Make sure you have installed the driver for the appropriate
module.

Interface (Ports & Jacks) Overview

Item Description

Built-In Microphone The built-in microphone allows you to record on your computer

The card reader allows you to use some of the latest digital storage cards. Push the
Card Reader Port card into the slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA) Port This port allows you to connect an external monitor, or Flat Panel Display, to get dual
video or simultaneous display on the LCD and external monitor/FPD.

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s
volume to a reduced level before connecting to this jack.

Line-In Jack The Line-In jack allows you to play audio sources through the computer’s speakers.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

Mini-IEEE 1394 Port This port allows a high-speed connection to various peripheral devices, e.g. external
disk drives and digital cameras (see note below).
Mini-IEEE 1394 Port
The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices.
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Item Description

RJ-11 Phone Jack This port connects to the built-in modem. You may plug the telephone line directly
into this RJ-11 telephone connection.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks
can be purchased at any computer store.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect
your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround
sound.

S-Video-Out Port Connect your television to your computer and view DVDs, VCDs or anything else
your computer can display. You will need an S-Video cable to make the connection.
Enable this port from the video driver controls.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-
speed peripherals such as keyboards, mice or scanners, and for high-speed
peripherals such as external HDDs, digital video cameras or high-speed scanners etc.
Devices can be plugged into the computer, and unplugged from the computer,
without the need to turn the system off (if the power rating of your USB device is
500mA or above, make sure you use the power supply which comes with the
device).

Optional Port Replicator Ports and Jacks

Item Description

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA) Port This port allows you to connect an external monitor, or Flat Panel Display, to get dual
video or simultaneous display on the LCD and external monitor/FPD.

Parallel Port Connect a parallel type printer to this port. The port supports ECP (Extended
Capabilities Port) and EPP (Enhanced Parallel Port) 1.7/1.9 modes.

Serial Port Connect a serial type mouse to this port.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-
speed peripherals such as keyboards, mice or scanners, and for high-speed
peripherals such as external HDDs, digital video cameras or high-speed scanners etc.
Devices can be plugged into the computer, and unplugged from the computer,
without the need to turn the system off (if the power rating of your USB device is
500mA or above, make sure you use the power supply which comes with the
device).
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Specification

Latest Specification Information
The specifications listed in this Appendix are correct at the time of going to press. Certain items
(particularly processor types/speeds and CD/DVD device types) may be changed or updated due
to the manufacturer’s release schedule. Check with your service center for details.

Processor
Intel Pentium® M Processor (478-pin) Micro-FC-PGA Package
Models 730/ 740/ 750/ 760/ 770/ 780
(µ0.09) 0.09 Micron Process Technology
2MB On-die L2 Cache & 533MHz FSB
1.6/ 1.73/ 1.86/ 2/ 2.13/ 2.26 GHz

Intel Celeron® M Processor (478-pin) Micro-FCPGA Package
Models 350/ 360/ 370/ 380/ 390
(µ0.09) 0.09 Micron Process Technology
1MB On-die L2 Cache & 400MHz FSB
1.3/ 1.4/ 1.5/ 1.6/ 1.7 GHz

Core Logic
Intel 915GM + ICH6-M

Memory
Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) 400 / 533 MHz
128-bit Wide DDRII (DDR2) Data Channel Memory
Expandable up to 2GB (256/ 512/ 1024 MB DDRII Modules)
(Note: Do Not Use Other Module Types)

Security
Security (Kensington® Type) Lock Slot

BIOS
One 4MB Flash ROM
Phoenix™ BIOS, Plug and Play

LCD
14.0" WXGA (1280*768) Flat Panel TFT

Video Adapter
Intel 915GM Integration
Intel® Graphics Media Accelerator 900 (Intel® GMA 900)
Dynamic Video Memory Technology DVMT 3.0 - Supports up to 128MB of Video Memory (dynamically allocated from
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system memory where needed)
Supports Analog Monitor Pixel Resolution up to 1600 * 1200 at 85Hz
Integrated High Quality 3D Graphics Engine Accelerator

Storage
One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive
Easy Changeable 2.5" 9.5 mm (h) IDE HDD with PATA (Parallel) Interface
Supports ATA 100/ 66/ 33

Audio
Integrated AZALIA Compliant Interface (HAD)
3D Stereo Enhanced Sound System
Sound-Blaster PRO™ Compatible
2 * Built-In Speakers
Built-In Microphone

Keyboard & Pointing Device
Winkey Keyboard
Built-In TouchPad with Scrolling Function

PCMCIA
One Type-II PCMCIA CardBus PC Card Slot

Interface
Four USB 2.0 Ports
One External Monitor Port
One Headphone-Out Jack
One Microphone-In Jack
One Line-In Jack
One S/PDIF Output Jack
One RJ-11 Jack for Plug & Play Fax/Modem
One RJ-45 Jack for 10Mb/ 100Mb/ 1000Mb Fast Ethernet
One Mini-IEEE 1394 Port
One S-Video-Out Port (supports HDTV)
One DC-in Jack

Note: External 7.1 CH Audio Output Support Configurable through Headphone, Microphone,
Line-In and S/PDIF Jacks

Card Reader
Embedded 4-in-1 Card Reader (MS/ MS PRO/ SD/ MMC)
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Communication
AZALIA 56K Plug & Play Fax/Modem v.90/92 Compliant
10Mb/ 100Mb/ 1000Mb Fast Ethernet
Intel® PRO/Wireless 2915ABG Mini PCI Wireless LAN Module
(Factory Option) Bluetooth Module - Version 1.2
(Factory Option) 300K PC Camera with USB Interface
(Factory Option) 1.3M PC Camera with USB Interface

Power Management
Supports ACPI 2.0
Power Button as Sleep/Resume Key
Supports Hibernate Mode
Supports Standby
Supports Battery Low Suspend
Supports Resume from Modem Ring
Supports Wake on LAN

Power
Full Range AC/DC Adapter 20V, 3.25A (65 Watts), 100~240V, 47~63Hz
Full Range AC/DC Adapter 20V, 5.25A (90 Watts), 100~240V, 50~60Hz (If using the optional Port Replicator)
6 Cell Smart Lithium-Ion Battery Pack, 4000mAH (44.4W)
6 Cell Smart Lithium-Ion Battery Pack, 4400mAH (48.8W)

Environmental Spec
Temperature

Operating:  5°C ~ 35°C
Non-Operating: -20°C ~ 60°C

Relative Humidity
Operating: 20% ~ 80%
Non-Operating: 10% ~ 90%

Physical Dimensions & Weight
333mm (w) * 243mm (d) * 24-33mm (h)
1.9 kg Without Battery
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Optional
Optical Drive Module Options:
DVD-ROM Drive Module
DVD/CD-RW Combo Drive Module
DVD-Dual Drive Module
Port Replicator (10/100 Base-T Ethernet Port, 4 * USB 2.0 Ports, Serial Port, Parallel Port, External Monitor Port, DC-In
Jack)
(Note: Port Replicator requires the supplied 90W power adapter)
Charger Box
(Factory Option) PC Camera with USB Interface
(Factory Option) Bluetooth Module - Version 1.2
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Notes
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